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Visual Studio 2017

* O que instalar?

Medificando — Visual Studio Community 2017 — 15.2 (26430.14)

Cargas de trabalho Componentes individuais Pacotes de idiomas

Windows (3) Resumo

2 Ugsenvoivimento Com a riatatorma vniversal...
.. Desenvolvimento com a Plataforma Universal do > Desenvolvimento para desktop com o .NET

-. Windows

v Desenvolvimento para desktop com C++
Crie aplicativos para a Plataforma Universal do Windows...

Incluido
v Recursos de drea de trabalho principais do Visua..

Desenvolvimento para desktop com o [NET Opcwnall
Compile aplicatives do WPF, do Windows Forms e de Conjunto de fe"ar.nemas ves +. 2017 V141 (x86, x..
Ferramentas de criagdo de perfil do C++
SDK do Windows 10 (10.0.15063.0) para Desktop...
Ferramentas do Visual C++ para CMake
Suporte a ATL do Visual C++

SDK do Windows 8.1 e SDK do UCRT

Suporte do Windows XP para C++

Suporte para MFC e ATL (x86 e x64)

Suporte para C++/CLI

Clann/C? (exnerimental

console usando e o .NET Framework.

Desenvolvimento para desktop com C++
Crie aplicativos classicos baseados no Windows usando o
poder do conjunto de ferramentas do Visual C++, ATLe

Local

C\Program Files (x86)\Microsoft Visual Studio\2017\Community
Tamanho total da instalagdo: 23 MB

Ao prosseguir, vocé concorda com a licenga da edicdo do Visual Studio selecionada. Também oferecemos a

possibilidade de baixar outros softwares com o Visual Studio. Este software é licenciado separadamente, como consta

nos Avisos de Terceiros ou na licenga de acompanhamento do produto. Ao prosseguir, vocé também concorda com .
essas licengas. Maodificar




Visual Studio

EQJ Start Page - Microsoft Visual Studic
File  Edit View Project Debug Team  Tools Test  Apalyze
= | 3.2 o | = =

Start Page & X

Get Started

New to Visual Studio? Check cut coding tutorials and sample

projects

Get training on new frameworks, languages, and technologies
Create a private code repo and backleg for your project
See how easy it is to get started with cloud services

Discover ways to extend and customize the IDE

Recent

This week

lj FaceBasics-D2D.sln
W C\Users\edirl\Desktop'\FaceBasics-D2DVFaceBasics-D...

FaceBasics-D2D.sln

Output

Show output from:

SRR Output

Window  Help
P Attach.. v | g% _

Open
Get code from a remote version

control system or open something
onyour local drive.

Checkout from:

& Visual Studio Team Services

el Open Project / Selution
2. Open Folder

% Open Website

New project
Search projecttemplates 2 -

Recent project templates:

B Aplicativo do Co... C++

2017

X &  Quick Launch (Ctrl+Q) Pl - ] x
Edirlei Soares de Lima - E

~ | Solution Explorer * o x

Developer News

Over 500 extensions in the VSTS/
TFS marketplace

In November of 2015, almost 2 years ago,
we launched the Visual Studio Team
Services (VSTS) Marketplace to further...
NEW quarta-feira, agosto 16, 2017

Announcing ASP.NET Core 2.0

The ASP.MET team is proud to announce
general availability of ASP.NET Core

2.0, This release features compatibility...
NEW quarta-feira, agosto 16, 2017

F# and .NET Core Roadmap Update
MNow that .MET Core 2.0 has been
released, we wanted to take some time
to talk about F# and .NET Core. F# has...
NEW quarta-feira, agosto 16, 2017

ELINLT =W Team Explorer
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Criar novo projeto: File -> New -> Project

ﬂ Start Page - Microsoft Visual Studio X & | Quick Launch (Ctrl+Q)
File | Edit View Project Debug Team Tools Test Analyze Window Help
New '3 Project. Ctrl-Shift+N

©  Start Page 1 File.. Ctrl+N
Close Project From Existing Code...

Open

Close Solution
Save Selected Items Ctrl+5

Save Selected Items As...

Get code from a remote version
control system or open something ° Developer NEWS

¥ SaveAll Ctrl+Shift+S  |and sample on your local drive.
Source Control r Checkout from:
— technologies ) . . Over 500 extensions in the VSTS/
e.ge Setup... ) ) & Visual Studio Team Services TFS marketplace
Print... Ctrl+P roject In November of 2015, almost 2 years ago,
N . we launched the Visual Studio Team
Account Settings... I k] Open Project / Solution Services (VSTS) Marketplace to further...
Recent Files 3 =3 Open Folder NEW quarta-feira, agosto 16, 2017
Recent Projects and Soluti r -
Seent Frejscts and solutions % Open Website Announcing ASP.NET Core 2.0
B EBat Alt+F4 The ASP.NET team is proud to announce

general availability of ASP.NET Core

R e Ce nt 2.0. This release features compatibility...

. NEW quarta-feira, agosto 16, 2017
New project

This week F# and .NET Core Roadmap Update
R Search project templates 2@ ~ Mow that .NET Core 2.0 has been

1 FaceBasics-D2D.sln released, we wanted to take some time

® Ch\Users\edirl\Desktop\FaceBasics-D2D"FaceBasics-D... Recent project templates: to talk about F# and .MET Core. F# has...

NEW quarta-feira, agosto 16, 2017

p== FaceBasics-D2D.sIn B Aplicativo do Co.. C++

Qutput
Show output from: = | | ‘ | 3

S Output

)

Edirlei Soares de Lima ~ E

Open [ i i
p @ Web Site... Shift+Alt+N Solution Explorer = 1 X

Solution Ex..

- m] x

| #

Team Explorer
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* Tipo de Projeto: Templates -> Visual C++ -> Win 32 Console
Application

— Nome do projeto e local onde o projeto sera salvo.

Mew Project ? x

P Recent NET Framework 452 - Sort by: Default - Search Installed Templates (Ctrl+E) P~

4 |nstalled -
Win32 Console Application Visual C++ Type: Visual C++
4 Templates

A project for creating a Win32 console

oy .
b Visual C# Win32 Project Visual C++ application
I+ Visual Basic
= Ty
4 Visual .C++ . R‘] Empty Project Visual C++
Universal do Windows
4
ATL D Makefile Project Visual C++
eral
Test
Win32
Visual F#

I JavaScript
I Other Project Types

Mot finding what you are looking for?

Open Visual Studio Installer

I Online

Name: MeuProjeto

Location: cusershedirl\documentsiwisual studio 2017\Projects -

Selution name: MeuProjeto Create directory for solution

["] Add to Source Control
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* Criacao do Projeto
— Next...
— Empty Project
— Finish

Win32 Application Wizard - MeuProjeto ? X\

D Welcome to the Win32 Application Wizard

Overview These are the current project settings:

Application Settings = Console application
Click Finish from any window to accept the current settings.

After you areate the project, see the project's readme. txt file for information about the
project features and files that are generated.

MNext = F\nit Cancel

v

Win32 Application Wizard - MeuProjeto 7 X

Application Settings

Overview Application type: Add common header files for:

Windows application

Application Settings

Console application

DLL

() Static library

Additional options:
Empty project

[ ][ )
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* Criar Novo Arquivo .C: Add -> New ltem

— Clicar com o botao direto do mouse sobre o nome do projeto para

acessar o menu. \

ﬂ MeuProjeto - Microsoft Visual Studio
File Edit View Project Build Debug Teamn Tools Test Analyze Window Help

-0 |@-w A

¥ | 57 Quick Lsunch (Ctr+0) P - o x

Edirlei Soares de Lima - E

Debug ~ x86 = P Local Windows Debugger ~ | 5

Solution Explorer > o x
AE-| -
Search Solution Explorer 2 =
fad Solution 'MeuProjeto’ (1
o Frojeto

& Build

eferences
Rebuild sternal Dependen
Clean leader Files
View » Esource Files
urce Files
Analyze 3
Project Only 3

Retarget Projects
Scope to This
Mew Solution Explorer View
Build Dependencies 3

New Item... Ctrl+Shift+ A Add 4
Existing Item... Shift+Alt+ A g  Class Wizard... Ctrl+Shift+X

Team Explorer

> 0 x
Project Proper ~

Mew Filter Manage MuGet Packages...

Reference... L Set as StartUp Project

Connected Service... Debug

s Class... Source Control

Qutput *%  Resource.. 3% cut Chrl+X MeuProjeto
| | i Paste Ctrl+V

Sh tput from:
ow output from ch\Usershedirl\d

MeuProjeto

X Remove Del
Rename

Unload Project

Rescan Selution

Open Folder in File Explorer roject name.

i Output
Error List [eifel Alt+Enter

eating project 'MeuProjeto’... project creation successful. 4 Add to Source Control «

Properties
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e Criar Novo Arquivo .C: Visual C++ - > C++ File (.cpp)

— Dar um nome para o arquivo e modificar a extensao para .c

Add New Item - MeuProjeto ? X

4 |nstalled Sort by: Default -| &= (1= Search Installed Templates (Ctrl+E) P~

4 IS |ﬁ Ce+ File (.cpp) Visual C++ Type: Visual C++
XAML

Creates a file containing C++ source code

Cod L
o IEI Header File (h) Visual C++
Data

Resource
Web
Utility
Property Sheets
HLSL
Graphics

b Online

Mame: main.c (
Location: c\Users\edirl\documentsivisual studic 2017\Projects\MeuProjeto’\MeuPrc =

| add || Cancel
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Pronto para programar!

EQJ MeuProjeto - Microseft Visual Studio X & | Quick Launch (Cirl+ ) P - B x
File Edit View Project Build Debug Team Tools Test Apalyze Window Help Edirlei Soares de Lima - E
= | iﬁ -2 W m | - ~ | Debug -~ |x86 = P Local Windows Debugger v‘ M R = ‘

mainc & X > 0 X

mMauProjeto - (Global Scope) -

Solution Explorer

Q& -

Search Solution Explorer O -

] Solution 'MeuProjeto’ (1
4 [%] MeuProjeto

[ =B References

& External Dependen
Header Files

"

I}"||"<

™
4+ ResourceFiles
4 .. SourceFiles

++ main.c

4
Solution Ex...

Teamn Explorer

1 x

Properties

Output

Show output from:

Error List JOlli0d

4 Add to Source Control «
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#include <stdio.h>

int main ()

{

int numl, num?2, resultado;

printf ("Digite o primeiro numero: ");
scanf ("sd", &numl) ;

printf ("Digite o segundo numero: ");
scanf ("%d", &num?2) ;

resultado = numl + numZ2;
printf ("A soma eh: %$d\n", resultado);

return 0O;



Visual Studio 2017

* Compilar programa: Build -> Build Solution

— Resultado do processo de compilacao

ﬂ MeuProjeto - Microsoft Visual Studio X | & | Quick Launch (Ctrl+Q) Pl = B x
File Edit View Project | Build | Debug Team Tools Test Analyze Window Help Edirlei Soares de Lima = E
- \ {3 -~ 2 Ml W % Build Solution Ctrl+Shift=B
Rebuild Solution

main.c # X
%] MeuProjeto

i Solution Explorer > I x
Clean Solution

o T
Build full program database file for selution fat & | ©
Run Code Analysis on Solution Alt+F11 Search Selution Explorer 2 ~

#include

WoR

Hlint main| o Build MeuPrajeto R Solution 'MeuProjeto’ (1
{ 4 %] MeuProjeto
P =B References

& External Dependen
Project Only 4 Header Files
scan Batch Build... 4+ Resource Files

resu +-| Source Files
prin Configuration Manager...

retu 1 Compile Ctrl+F7

[T

int Rebuild MeuProjeto
prin
scan
prin

Clean MeuProjeto

[N

++ main.c

4
Solution Ex... WEEHRSTIRIE

Properties > I X

D
B Cs++
Output X (Name) main
Fil A\Users\ed
Show eutput from: Build - | | = | = | =a 1= C\Usersier

1>c:\program files (x86 pndows kits\l@\include\1@.8.15863.@\ucrt\stdio.h(1272): note: see declaration of 'scanf’ FullName | main
1>MeuProjeto.vexproj -> &usersiedirlidocumentsi\visual studio 2817\Projects\MeuProjeto\DebugiMeuProjeto.exe IsDefault  False
1xMeuProjeto.vexproj -» c:\users\edirlidocuments\visual studio 2817\Projects\MeuProjeto‘Debugi\MeuProjeto.pdb (Partial PDB) IsDelete False
1>Done building project "MeuProjeto.vecxproj”. |sFinal False
Build: 1 succeeded, @ failed, 8 up-to-date, ® skipped

Ce+
Error List {8lis03

4 Add to Source Control =
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* Executar programa: Debug -> Start Without Debugging

:4-] MeuProjeta - Micrasoft Visual Studio X | &' | Quick Launch (Ctrl+ ) Pl - 0 x
File Edit View Project Build | Debug | Team Tools Test Analyze Window Help Edirlei Soares de Lima - m
Q- F I - T ] Windows + ndows Debugger ~ | 57 _ LI e | -

w . Graphics 3 -
3 mainc 8 X Solution Explorer = 1
; [ MeuProjeto P Start Debugging = - & maing ae-lm- "
5 1 #include <stdig P Start Without Debugging Ctrl+F5 | = o
] 5 v = Solution Explorer =
o 2 @ Performance Profiler... Alt+F2 SR
3 Zint i O P
= ;” main() & Attach to Process... Ctrl+AltsP m;u:;nnpr\neupmjm (
=X . e 4 euProjeto
E— lm‘: :imlén Other Debug Targets L - =W References
- pranm E ',l‘g Profiler r External Dependen|
P
scanf("%d" ) Ny
: printf("Dig ¥ Stepnto F11 71 Header Files
g scanf("%d",| my " o + Resource Files
16 resultado = ° SO AL 4 = SourceFiles
11 printf("A 5 T Breakpoint F9 P #+ main.c
2 return 8; Mew Breakpoint

BN C:\Windows\system32icmd.exe

primeiro num ~
ndo num
1@
ialquer t

Import DataTips ...

Options...

MeuProjeto Properties...

100 % -

Output

Show output from: | Build - §
= Build: @ succeeded, @ failed, 1 up-to-date, @ skipped

SICTAREY Output

Build succeeded
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#include <stdio.h>

int main ()

{

int numl, num?2, resultado;

printf ("Digite o primeiro numero: ");
scanf ("sd", &numl) ;

printf ("Digite o segundo numero: ");
scanf ("sd", &num);

resultado = numl + num?2;
printf ("A soma eh: %$d\n", resultado)

retur 0;
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* Compilar programa: Build -> Build Solution

— Falha no processo de compilacao

ﬂ MeuProjeto - Microsoft Visual Studio W | 57 | Quick Launch (Ctd+Q) Pl - B x
File Edit View Project Build Debug Team Tools Test Apalyze Window Help Edirlei Soares de Lima ~ E
ie-o|@-2 @M 9 - Debug -/ ~ P Local Windows Debugg i = -

* | Solution Explorer > X
[®] MeuProjeto (Global Scope) o e ,| Bo
1 #include <stdio.h>

"

Search Solution Explorer 2 ~

[

=lint main()| fad Solution 'MeuProjeto’ (1 i
. 4 [%] MeuProjeto

lm.: ::';LDM'EE‘ res?lt?doi ") b =8 References

rin igite o primeiro numero: ");
ZEEHf( "%d"? &numl’;; & External I?Ependen
printf("Digite o segundo numero: "); Header Files
scanf("%d", &num); Resource Files
resultado = numl + num2; Source Files
printf("A soma eh: %d\n", resultado) ++ main.c

retur @;

L

W oo @

4
Solution Bx.. WEENRSTILIES

Properties >R X

o | &

B C++

(Mame) main
File c\Users\ed
- ‘ ‘ = a FullName main
tudin.2917\prnjacts\meupr‘oj‘etﬂ\meuprnje‘éo\main.c(Q): warning C4996: 'scanf': This function or vi* IsDefault  False
1»c:\program files (x86)\windows kits\18%\include'1®.8.15863.8\ucrt\stdio.h(1272): note: see declaration of 'scanf’ IsDelete False

1>Done building project "MeuProjeto.wcxproj"™ -- FAILED. |sFinal False

Build: @ succeeded, 1 failed, @ up-to-date, @ skipped
C++

/GRS Output

1 Add to Source Control =




Lista de
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Erros: View -> Error List

J MeuProjeto -

File  Edit | View
° - L3

[ Meu

ESi . O |

A0 W 0 >

Microsoft Visual Studic
Project  Build Debug Team  Tools Test  Analyze Help
Code F7 = P Local Windows Debugger = ‘ M _ S ‘ =
Open
Open With... bal Scope) ~ @ main()
Selution Explorer Ctrl+Alt+L
Team Explorer Ctrl+], Ctrl+M
Server Explarer Ctrl+Alt+5
Bookmark Window Ctrl+E, Ctrl+W
Call Hierarchy Ctrl+ Alt+K RE
Class View Ctrl+Shift+C H
Code Definition Window Ctrl+], D
Object Browser Ctrl+Alt+) o)
Error List Ctrl+], E
OQutput Ctrl+Alt+0
Task List Ctrl+], T
Toolbox Ctrl+Alt+X
Motifications Ctri+W, N

Find Results
Other Windows
Toolbars
Shift+Alt+Enter
Shift+Alt+M

Full Screen
All Windows
Navigate Backward
MNavigate Forward

Next Task

Ctrl+-
Ctrl+Shift+-

Previous Task - |
Properties Window F4

Property Pages Shift+F4 BILED.

Error List jS]iieI

Bulld: @ succeeded, 1 failed, @ up-to-date, @ skippe:

=

ra

jects\meuprojeto\meuprojeto\main.c(9): warning C4996: 'scanf':
16.6.15863.0\ucrt\stdio.h(1272): note: see declaration of 'scanf'

X &’ | Quick Launch (Ctrl+Q) P = | 4

Edirlei Soares de Lima - E

Solution Explorer * 0 X

@dE-o-
Search Solution Explorer 2 =

] Solution 'MeuProjeto’ (1§
4 [%] MeuProjeto

P - References

= External Dependen)

Header Files

Resource Files

ubeig

500 J13sC

Source Files
++ main.c

4
Solution Bx.. EEETESILTES
Properties v B x
main VCCodeFunction
o | F

Bl C++ -
(Name) main

File c\Users\ed
FullMName
IsDefault  False
IsDelete False
IsFinal False -

C++

main

This function or w:*

4 Add to Source Control =
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e Lista de Erros: View -> Error List

EQJ MeuProjeto - Microsoft Visual Studio X & | Quick Launch (Ctrl+Q) Pl = O x
File  Edit View Project Build Debug Team Tools Test Analyze Window Help Edirlei Soares de Lima ~ E
Q- | iﬁ Al | w | - ~ | Debug ~| x86 ~ P Local Windows Debugger ~ | 5 ;

Solution Explorer v I x
[l MeuProjeto (Global Scope) @ & ,| o -
#include <stdio.h>

ubelg

|dxg Jaasag
5

0] I

Search Solution Explorer 2 -

WoR

5|

-lint main() m Solution 'MeuProjeto’ (1§
{ | 4 [%] MeuProjeto

int numl, num2, resultado; b
printf("Digite o primeiroc numero: ");
scanf("%d", &numl);
printf("Digite o segundo numero: ");
scanf("%d", &num);
resultado = numl + num2; Source Files
printf("A soma eh: ¥d\n", resultado) ++ main.c
retur @;

Je [ [ale] I E:
[

=B References
= External Dependen
Header Files

@

Resource Files

wooa s

Error List

Entire Solution - | €3 6Errors 1 0of 2Warnings | D 0 Messages | Xy | Build + IntelliSense Search Error List

NG Tearn Explorer

" Code  Description Project File Line Suppression State

identifier "num" is il 4

abc H H

& EODZ20 undefined MeuProjeto main.c 9
E0DGS  expecteda’; MeuProjeto main.c 12

C2065 .num.:.undeclared MeuProjeto main.c
identifier
syntax error: ; main
C2146  missing ;' before MeuProjeto main.c c\Users\ed
identifier ‘retur’ FullMame  main
C2065 .retur.:.undeclared MeuProjeto rmain.c IsDefault | False
identifier |sDelete False
syntax error: |Final Fake
C2143  missing ;' before  MeuProjeto main.c srina 2

‘constant’ C++

Output

A Add to Source Control a
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B8 start here - CodexBlocks 16.01 - O x
File Edit View Search Project Build Debug Fortran  wxSmith  Tools Tools+  Plugins DoxyBlocks  Settings Help
FTeEHA e UmaAaisrien iwszezsl g6 v N @ |5 M|
v v| == P REB
i -3 v||q-ab_f§}m_x|;[§|:||ﬁg|E@|:ﬂmm\@\6\|sc|g| v|-_1gw&|
|| Starthere X |
~
OWorkspace
. The open source, cross-platform IDE
Release 16.01 rev 10702 (2016-01-25 19:50:14) gec 4.9.2 Windows/unicode - 32 bit
.u Create a new project @ Open an existing project Q Tip of the Day
Visit the Code::Blocks forums Reporta bug or reguest a new feature
Recent projects w
Logs & others x
ﬂ j CodexzBlocks Xl QSeardﬂ results X] j Ceco X] QBuiId log X] ? Build messages X] j CppCheck X] j CppCheck messages 3
A
v
default =

Lembre-se de instalar a versao codeblocks-16.01mingw-setup.exe



http://sourceforge.net/projects/codeblocks/files/Binaries/16.01/Windows/codeblocks-16.01mingw-setup.exe
http://sourceforge.net/projects/codeblocks/files/Binaries/16.01/Windows/codeblocks-16.01mingw-setup.exe
http://sourceforge.net/projects/codeblocks/files/Binaries/16.01/Windows/codeblocks-16.01mingw-setup.exe
http://sourceforge.net/projects/codeblocks/files/Binaries/16.01/Windows/codeblocks-16.01mingw-setup.exe
http://sourceforge.net/projects/codeblocks/files/Binaries/16.01/Windows/codeblocks-16.01mingw-setup.exe

CodeBlocks

* Criar novo projeto: File -> New -> Project

w Start here - Code::Blocks 16.01

[ Open... Ctrl-0
Open with hex editor

Recent projects r

Recent files 4

Impaort project 4

T [ @

o |@®

=

Export r
Properties...

@ ouit Ctrl-Q

File Edit View Search Project Build Debug Fortran

Empty file

Class...
Project...
Build target...
File...
Custom...

From template...

wxSmith  Tools Tools+  Plugine DoxyBlocks  Settings  Help

Ctrl-Shift-N Db BE GI %D gl 6 | &

Massi Shneiderman diagram COde: : B |OC kS

others

The open source, eross-platform |DE

Release 16.01 rev 10702 (2016-01-25 19:50:14) gee 4.9.2 Windows/unicode - 32 bit

ﬁ Create a new project \!t Open an existing project ) Tip pfthe Da

" Visit the Code::Blocks forums  Report a bug or reguest a new feature

-

Recent projects

/| CodexBlocks X

Create a new project

_)3 Search results X _'] Cecc X QBui\d log ﬁ_“ Build messages X _'] CppCheck % _"] CppCheck messages

default

i}




CodeBlocks

* Tipo de projeto: Console Application

Mew from template
Projects Category: | <all categories = w
Build targets — =
Filez m $ ~
Custom N ) ) -
User templates ARM Project  AVR Project  Code:: _ _Lorjsnll:
plugin application
&4 ©6 B [
D application Direct Dynamic Link Empty project
project Library
FLTK project  Fortran DLL Fortran Fortran library
application
GLFW GLUT
e e 8 S
GLFW project  GLUT project GTK+ project Irrlicht project
W
TIP: Try right-dicking an item
1. Select a wizard type first on the left
2. Select a spedific wizard from the main window (filter by categories if needed)
3. Press Go

Cancel

View as

@ Large icons

() List




CodeB|

Criacao do projeto
— Next

ocks

Welcome to the new console application wizard!
This wizard will guide you to create a new console application.

When you 're ready to proceed, please dick Text™...

O

Console application

B8 Console

Please select the langlzge you want to use.

Please make a selev

C++




CodeBlocks

* Criacao do projeto
— Nome do projeto e local onde o projeto sera salvo.

— Next

— Finish

Console application

B¢ Console

Please select the foldef§f where you want the new project
to be created as well af its title.

Project title:
|MeuPr0jet0| |

Folder to create project in:
|C:'|,Users'|,edir|'|,Deskb3p'|, |

Project filename:
|MeuPr0jetD.d3p |

Resulting filename:
|C :\Users'\edirl\Desktop\MeuProjeto\MeuProjeto. chp |

Console application

B¢ Console

Flease select the compiler to use and which configurations
wou want enabled in your project.

Compiler:
GNU GCC Compiler [
Create "Debug” configuration:
"Debug” options
Qutput dir.: |bin ‘Debug |

Objects output dir. : |Dbj \Debug |

Create "Release” configuration:

"Release” options

Output dir.: |bin \Release |

Objects output dir.: |0bj \Release |




CodeBlocks

* Pronto para programar!

— Abra o arquivo .c criado automaticamente no projeto

BB main.c [MeuProjeto] - Code:Blocks 16.01 — ] %
File Edit VYiew 5Search Project Build Debug Fortran wxSmith Tools Tools+ Plugins DoxyBlocks Settings Help

TeEd e 4 | QB G b % & B b ML AT | &
ML ~ viesPBB
. Voo L Pl 0 KA \ laals CH a4
M t x
lanagemen maine
4 | Projects mbols Files P 1
O Workspac 2
=g MeuPM 3
== Sources S int main()
6 printf ("Hello world!\n"):
7 return 0;
g
< >
Logs & others x
4| J) CodezBlocks (4, Search results x| fcee x| QyBuidlog X \:"‘Bulld messages x| Jj CcppChede x| /| CppCheck messages »
MativeParser::CreateParser(): Finish creating a new parser for project 'MeuProjeto’ -~
MativeParser::OnParserEnd(): Project ‘MeuProjeto’ parsing stage done!
v

[

ChUsers\edirl\Desktop\MeuProjeto\main.c Windows (CR+LF) WINDOWS-1252 Line 1, Column 1 Insert Read/Write default




CodeBlocks

#include <stdio.h>

int main ()

{

int numl, num?2, resultado;

printf ("Digite o primeiro numero: ");
scanft ("sd", &numl) ;
printf ("Digite o segundo numero: ");

scanf ("%d", &num?2) ;
resultado = numl + numZ;
printf ("A soma eh: %d\n", resultado);

return 0O;



CodeBlocks

 Compilar programa: Build -> Build

— Resultado do processo de compilacao

w main.c [MeuProjete] - Code:Blocks 16.01 — [m]
File Edit View Search Project  Build Debug Fortran  wxSmith  Tools Teols+ Plugins Doxyfflocks Settings Help
‘FeBEd « 3| 3 nEE ; v T 62 %D g Gl | &)
;| <global> Compile current file Ctrl-Shift-Fo v|i @ C>| o
= Run Ctrl-F10
Al | BN I
. % Build and run F9 . -
CERE N * ||« Rebuild Ctrl-F11
4 | Projects | Symbols Filez P Clean
Waork:
O. > spa(e. Build workspace
= ’ MeuProjeto i
H Rebuild workspace
=83 Sources
: main.c Clean werkspace bultado:
@ EImsiro numszo:ft)
Errors ¥ raunde aumeza: |
Select target »
num? ;
12
13 printf("A soma =h: %d\n", resultafo):
14
15 return O;
16 }
17
<
Logs & others
4 j Code::Blocksf| ¢ q_.f} Search results » j Ceec 3| €3 Buildlog 3¢ ﬁ__‘BuiId messages » j CppCheck X j CppCheck messages
mingwiZ-gec.exdl -Wall -g -c C:\Users\edirl\Desktop'MeuProjeto\main.c -o obj\Debugimain.o
mingw32-g++_ex\f -0 bin\Debug\MeuProjeto.exe objiDebug\main.o
Output file is Lin\Debug\MeuProjetoc.exe with size 25.€5 EB
Process terminated with status 0 (0 minuts(s), 0
0 srror(s), 0 warning(s) (0 minute(s), 0 second(s))
Build current project Windows (CR+LF) WINDOWS-1252 Line 17, Column 1 Insert Read/\Write default =5
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* Executar programa: Debug -> Run

M8 main.c [MeuProjeto] - Code:Blocks 16.01 — [m] x
File Edit View Search Project Build Debug Fortran wxSmith Tools Tools+ Plugins DoxyBlocks Settings  Help
A EEN & B ¥ i3 Build cukFy | vl b YE QI %D gl Gl [#]
[ <global> Compile current file Ctrl-Shift-F9 [ vie > | EB
¥ Run 10
k e f‘f. Build and run Fo |
SEXET VA * | & Rebuild cul-F1 |
Projects | Symbols Files » Clean i
Q Workspace .
i..'ll MeuProjeto 2u:]|d T;orlcs;:ca
5B Sources ebuild workspace
main.c S i gultado;
a Fimeiro numero: ") :
Errors b tampdo numexo: ")/
Select target L
nuom2; | B0 CiUsers\edirhDesktopMeuProjetoibin\DebugMeuProjeto.exe — O x
i
12
13 printf("A soma =h: ¥d\n", ¥ op rimeiroc numero A
14
s return o: rite o segundo numero:
16 }
17
returned @
<
Logs & others
/| Code::Blocks 4 Search results Al Ci
—————————————— Run: Debug in MeuProjeto (com
Checking for istence: C:\Usershedirl\Deskty
Executing: "C:\Program Files €)\CodeBlocK
\MeuProjeto.exe" (in C:\Users'\edirl\Desktog
|[Process terminated with status -1073741510 (
Run current project Windows (CR+LF) WINDOWS-1252
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#include <stdio.h>

int main ()

{

int numl, num?2, resultado;

printf ("Digite o primeiro numero: ");
scanft ("sd", &numl) ;
printf ("Digite o segundo numero: ");

scanf ("%d", &num) ;
resultado = numl + num?Z2;
printf ("A soma eh: %$d\n", resultado)

retur 0;
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Compilar programa: Build -> Build Solution

— Falha no processo de compilacao e lista de erros

w main.c [MeuProjeto] - CodenBlocks 16.01

File Edit View Search Project Build Debug Fortran  wxSmith  Tools Toels+  Plugins DoxyBlocks  Settings Help

CeBa % v ¥ | Q&G > G o O [pbo Vi B 4262 4D 6 | &
¢ «global> ~ | main{) : int
; vl e o Joahsa il | O] | | | |
Management X
- main.c X
4 | Projects | Symbals Files W 1
OWorkspace 2
=] ’ MeuProjeto 3 int main()
= Sources 4 1
..... main.c 5 int numl, num2, resultado;
8 printf ("Digite © RIAMSIIO DumeIon: ")
7 zcanf ("%d", Lnuml);
S printf ("Digiks © 3sQunde numeza: ")
Y| scanf ("%d", &num);
10
11 resultado = numl + num2:
13 printf("A soma eh: %d\n", resultado)
14
15 retur 0:
16
17 =
€ >
Logs & others x
4 jCcda::BIod@ ble ';%,Searchresuhs X| ficge X $yBuldlog # Build messages ﬁCppChed< ¥ | /| CppCheck messages 13
File Line Message
=== Build: Debug vueurrzcjecc {compiler: GNU GCC Compiler] =—
C:\Usershedirl... In function 'main'?
C:\Usersh\edirl... % error: 'num' undeclared (first use in this functiomn)
C:\Usershedirl... 3 note: each undeclared identifier is reported only once for each function it appears in
C:i\Usershedirl. 15 error: expected ';' before 'retur’'
C:\Usersiedirl. .. 16& warning: control reaches snd of non-void function [-Wrsturn-typs]
=== Build failed: Z error(s), 1 warningis) (0 minute(s), 0 second(s)) ===
Clsers\edirl DesktopiMeuProjetolymain.c Windows (CR+LF) WINDOWS-1252 Line 9, Column 1 Insert Read/Write default
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Ideone.com - Online Comp| > +

@ @ httpsy//ideone.com ¢ Q Pesguisar wBa ¥ & QO -
IdBOﬂEn # new code

«f» enter your source code or insert template or sample or your template
1 #include <stdio.h>

Bl o ¢ Ophere online judge
: retu:::arwa Boss e Learn How to Code

6 }

7

C~ | @sidn || @ e @& moreoptions
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* Selecionar linguagem: C

— O
Ideone.com - Online Compi > 4

(O @ https://ideone.com ¢ Q Ppesquisar w8 4 @ S~
idEDne.f‘.:n N # new code

</> enter your source code or insert template or sample or your template
1 #include <stdio.h>

2 . -
- int mainueta) ¢ ©phere online judge
4 LI wvour code gnes here
Learn How to Code
popular others
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* Pronto para programar!

= [m]
Ideone.com - Online Compl 2 4

c Pesquisar o E ¥ A 9 -
IdEOﬂe 0l # new code

<f» enter your source code or insert template or sample or your template
1 #include <stdio.h>

gv int main(wvoid) { gphere Online jUdge
4 {// your code goes here

5 return 8; ¢ Learn How to Code

6 %

7

Ca a sidin @ o a  more options

We use cookies to improve our senvices. If you continue without changing your settings

'l assume that you are happy to receive all cookies on ldeone website. 0K
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#include <stdio.h>

int main ()

{

int numl, num?2, resultado;

printf ("Digite o primeiro numero: ");
scanft ("sd", &numl) ;
printf ("Digite o segundo numero: ");

scanf ("%d", &num?2) ;
resultado = numl + numZ;
printf ("A soma eh: %d\n", resultado);

return 0O;
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 |Informar dados de entrada: stdin

Ideone.com - Online Compi 3¢ +

€ O @ nhttpsy//ideone.com ¢ Pesquisar wBE ¥ & 9 O
|deone 0l # new code

¢</> enter your source code or insert template or sample or your template
1 #include <stdioc.h>

2 s .

- _— Ophere online judge
4~

5 int numl, num2, resultado; Learn How to Code
[ printf("Digite o primeiro numero: ");

7 scanf("%d", &numl);

8 printf("Digite o segundo numero: ");

9 scanf("&d", &numl);

1e

11 resultado = numl + num2;

12

13 printf("A soma eh: %d\n", resultado);

14

15 return 8;

16}

17

& enter input (stdin)

2
8

C Q stdin s &  more options




IDEOne

Compilar e executar programa: Run

Ideone.com - Online Compi 3¢ +

€ O @ nhttpsy//ideone.com

¢<f> enter your source code or insert template or sample or your

1 #include <stdio.h:

2

3 dint main()

4~

5 int numl, num2, resultado;

[ printf("Digite o primeiro numero: ");
7 scanf("%d", &numl);

8 printf("Digite o segundo numero: ");
9 scanf("&d", &numl);

1e

11 resultado = numl + num2;

12

13 printf("A soma eh: %d\n", resultado);
14

15 return 8;

16}

17

& enter input (stdin)

2
8

C Q stdin [~ ] o & more options

c Pesquisar

# new code

template

wBe ¥+ & 9 O

Ophere online judge
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* Resultado da execucao

2

Success

Q stdin

Ideone.com - mI8QPS - Onll > <=

€ & httpsy/ideone.com/mISQPS

ideone.-on

Frork &download
i ude <stdioc.h>

int main()
int numl, num2, resultado:
printf ("Digite o primeiro numero: ");
gcanf(":d", snuml);
printf("Digite o segundo numero: ™);
scanf ("%d", snum2);
resultado = numl + num2;

printf({"L soma eh: %d\n", resultado):

0;

® comments (0)

B8
<(

Digite o primeiro numero: Digite o segundo numerc: A soma eh: 1@

wB 3 A9 O

http-//ideone.com/mi8QPS

language: C
created 2 seconds ago
visibility @ public

< Share or Embed source code

<script src="hitp-/fideone_com/e js/miBAPS”
type="textfjavascript" =</script=
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#include <stdio.h>

int main ()

{

int numl, num?2, resultado;

printf ("Digite o primeiro numero: ");
scanft ("sd", &numl) ;
printf ("Digite o segundo numero: ");

scanf ("%d", &num) ;
resultado = numl + num?Z2;
printf ("A soma eh: %$d\n", resultado)

retur 0;
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Compilar e executar programa:

— Falha no processo de compilacao e erros

Ideone.com - mIBQPS - Onli X =+

€ (0@ nhtipsy/ideone.com/mI3QPS

ideone.com

esc to close
<f> source code
1 #include <stdio.h>

close fullscreen "

3 dint main()
4~ |{
s int numl, num?, resultado;
3 printf{"Digite o primeiro numero: ");
7 scant("#%d"”, &numl);
8 printf("Digite - >
g scanf("%d", Znu);
=]
11 resultadoe = numfl + numZ;
1z
13 printf("4 soma fh: %d\n", resultado)
14
15 retur 2;
16 3

Q input % Output
Compilation error time: 0 memory: 8432 signal:0
prog.c: In functien ‘main’:

r ]

prog.c:9:16: error: ‘num
scanf("%d", &num);

Frars

syntax highlight

-~

undeclared (first use in this functien)

prog.c:9:16: note: each undeclared identifier is reported only once for each functio

n it appears in

prog.c:15:3: error: expected ‘;’ before ‘retur’

W

e ¥ & 9 O
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language: C
created 2 seconds ago
visibility @ public

< Share or Embed source code
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type="text/javascript” »</script=
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